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1 Systemvoraussetzungen 

EndNote Libraries sind plattformübergreifend verwendbar (Windows und Macintosh). 

Es ist eine Internetverbindung nötig zur Registrierung, für Online-Recherchen und für die automatische 
Aktualisierung von Datensätzen sowie für EndNote Online. 

1.1 Windows 

Systemanforderungen 

 Windows 10 (nicht kompatibel mit Windows 7 und 8) 
 1 Gigahertz (GHz) oder schneller x86-bit oder x64-bit Prozessor 
 600 MB freier Festplattenspeicher 
 Minimum 2 GB verfügbarer RAM 

Textverarbeitung 

 Microsoft Word [CWYW] für Windows: 2010, 2013, 2016, 2019, Office 365 (nur lokal installierte 
Desktop-Version) 

 Apache OpenOffice [CWYW] für Windows: 3.x, 4.x 
 LibreOffice [CWYW] für Windows: 4.x, 5.x, 6.x (32-bit) 
 Partner CWYW Integration: Wolfram Mathematica 8 

1.2 Mac 

Systemanforderungen 

 macOS 10.14 oder 10.15 
 Intel-basierter Macintosh 
 Festplatte mit mindestens 700 MB freiem Festplattenspeicher 
 Minimum 2 GB verfügbarer RAM 

Textverarbeitung 

 Microsoft Word [CWYW] für macOS: 2016, 2019, Office 365 (nur lokal installierte Desktop-
Version) 

 Partner Integration für Cite While You Write: Apple® Pages 
 Partner CWYW Integration: Wolfram Mathematica 8 

1.3 EndNote Online Kompatibilität und Systemvoraussetzungen 

Browser Support für Web-Applikationen* 

 Microsoft Internet Explorer®8.x (32 Bit) oder höher 
 Firefox® 27 oder höher 
 Safari® 5.0 oder höher  
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 Chrome® 31 oder höher 
 Browser Support für Web Capture** 

Add-on* 

• Microsoft Internet Explorer®8.x (32 Bit) oder höher 
• Firefox® 27 oder höher 

Bookmarklet* 

• Microsoft Internet Explorer®8.x (32 Bit) oder höher 
• Firefox® 27 oder höher 
• Safari 5.0 oder höher 
• Chrome 31 oder höher 

*Dies gilt für Macintosh und Windows-Versionen des Browsers gleichermaßen, Ausnahme Internet 
Explorer, der nur für Windows verfügbar ist. 

** Cookies und JavaScript müssen aktiviert sein. 

Quelle: www.endnote.de 

  

http://www.endnote.de/
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2 Erste Schritte in Endnote 

Um EndNote zu starten, gehen Sie im Startmenü auf Programme > EndNote und öffnen Sie das 
Programm. Akzeptieren Sie allfällige Lizenzbedingungen und eventuelle Updates, über die Sie EndNote 
informiert. 

Mit folgenden Schritten legen Sie eine neue Library an: 

1. Wählen Sie im Menü File den Befehl New. 
2. Im Fenster New Reference Library wählen Sie den gewünschten Speicherort aus und vergeben 

einen Namen für die EndNote Library. 
3. Klicken Sie auf Speichern. 

Dateitypen und Backups 

Für jede EndNote Library (.enl-Datei) wird ein gleichnamiger Ordner (.data) angelegt, in dem zur Library 
gehörende Dokumente (z.B. PDFs) abgelegt werden. Dateien mit der Endung .enlx enthalten eine 
komprimierte Library. Diese enthält die Daten der .enl-Datei sowie des dazugehörigen .data-Ordners in 
komprimierter Form. 
EndNote erstellt keine automatischen Backups. Erstellen Sie deshalb regelmässig selbst ein Backup. 
Wählen Sie dazu im Menü File den Befehl Compressed Library (.enlx) … .  
Die Compressed Library enthält alle zur EndNote Library gehörigen Daten: Alle Bibliographischen 
Daten, PDF File Attachments (wenn ausgewählt), Term Lists und Groups. Nicht dazu gehören Output 
Styles, Import Filter und Connection Files. Diese sind Teil der EndNote-Installation und nicht der Library. 
Auch die in den EndNote Preferences getroffenen Einstellungen sind nicht Teil der Compressed Library. 

EndNote ist folgendermaßen aufgebaut: 

  
 Abbildung 1. Aufbau Endnote (TUM Universitätsbibliothek, 2021) 
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Datenbankbereich 

Im Datenbankbereich werden entweder alle Titel aus Ihrer Bibliothek, aus der aktuell markierten Gruppe 
oder die Ergebnisse einer Suche angezeigt. Mit dem Symbol können Sie Ihre Titel manuell 
hinzufügen. 

Vorschau und Editierbereich 

In diesem Bereich können Sie zwischen den Tabs Summary und Edit wählen. Im Tab Edit werden die 
bibliografischen Informationen zu dem aktuell markierten Titel angezeigt und können in diesem Fenster 
bearbeitet werden. 
Im Tab Summary werden die Informationen zu einem markierten Titel so angezeigt, wie sie in einer 
Literaturliste in Word erscheinen würden, sowie alle PDFs, die Sie dem Titel hinzugefügt haben. Hier 
können Sie auch Ihren aktuellen Zitierstil wählen, welcher in EndNote als Output Style bezeichnet wird. 
Sie können später in Ihrem Word-Dokument jederzeit einen anderen Zitierstil wählen. 

Synchronisierung mit Sync-Funktion 

EndNote bietet die Möglichkeit, die Daten aus Ihrer EndNote-Desktop-Bibliothek mit den Daten Ihres 
EndNote-Web-Kontos zu synchronisieren. Hier können Sie den Synchronisierungsvorgang starten. 

Gruppen 

Hier können Sie Ordner (genannt Groups) erstellen, um Ihre Literatur zu sortieren. Es gibt auch 
vorgegebene, nicht dauerhafte Gruppen wie Recently added, Unfiled und Trash.  
Recently added enthält alle kürzlich hinzugefügten Titel (per Download oder Online-Suche), ist aber 
jedes Mal leer, wenn Sie Ihre Bibliothek schliessen und erneut öffnen. 
Unfiled enthält alle Titel, die in keiner Gruppe enthalten sind. Trash enthält alle Titel, die in dieser Sitzung 
gelöscht wurden. Auch dieser Ordner wird nach jedem Schliessen und erneutem Öffnen Ihrer Bibliothek 
leer sein. All References enthält alle Referenzen Ihrer Bibliothek, egal in welcher Gruppe. 

Find full text 

Hier können Sie sehen, für welche Titel Sie gerade nach Volltexten (PDFs) suchen und für welche Sie 
vielleicht schon welche gefunden haben. 

Online Search 

Um eine Online-Suche durchzuführen, wählen Sie eine Datenbank oder einen Bibliothekskatalog. 
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3 Titel in Endnote aufnehmen und bearbeiten 

Für den Import von Literaturdaten in EndNote gibt es drei Möglichkeiten: 

1. Sie geben den Titel per Hand ein.  

2. Sie recherchieren in einer Literaturdatenbank oder einem Bibliothekskatalog. Die gefundenen 
Treffer exportieren Sie nach EndNote.  

3. Sie arbeiten in EndNote und recherchieren von hier aus in Literaturdatenbanken und 
Bibliothekskatalogen. Die gewünschten Daten importieren Sie in EndNote. 

Im Folgenden werden alle drei Möglichkeiten an Beispielen erläutert.  

3.1 Titeleingabe per Hand 

 
Abbildung 2. Titel in Endnote aufnehmen (TUM Universitätsbibliothek, 2021) 

1. Wählen Sie im Menü References den Befehl New Reference. Ein neuer, leerer Datensatz wird 
geöffnet. Alternativ klicken Sie auf das Symbol 

2. Wählen Sie aus der Auswahlliste Reference Type* den einzugebenden Dokumenttyp aus, z.B. 
Journal Article, Book Section usw. Die Eingabefelder ändern sich je nachdem, welchen 
Dokumenttyp Sie auswählen. Neue Titel nimmt EndNote automatisch mit dem Reference Type 
Journal Article auf.  

3. Geben Sie alle relevanten Daten in die jeweiligen Felder ein.  

Personen- und Institutionsnamen: Geben Sie Personennamen nach dem Muster Nachname, 
Vorname ein. Bei Institutionsnamen nennen Sie die Institution und setzen anschliessend ein Komma. 
Bsp.: Universität Bern,  
Ist im Namen der Institution bereits ein Komma enthalten, setzten Sie hier zwei Kommas.  
Bsp.: University of California,, Berkeley,  

(Seiten-)Zahlen: Geben Sie immer nur die reinen Zahlen an – kein p. für page oder S. für Seite. Diese 
Angaben werden, dem gewählten Zitationsstil entsprechend, ergänzt.  

Mehrere Einträge in einem Feld: Haben Sie für ein Feld mehrere Einträge, z.B. mehrere Autoren, 
Keywords o.ä., dann geben Sie jeden Eintrag in eine neue Zeile ein.  

Beim Schliessen des Fensters werden die Daten gespeichert. Neue Autorennamen, Keywords und 
Journals, die noch nicht in der Datenbank vorkommen, werden rot angezeigt. 
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Warum ist der Reference Type wichtig?  

Vom Reference Type hängt ab, wie eine Quelle im Literaturverzeichnis angegeben wird. Wählen 
Sie den falschen Reference Type, wird Ihre Quelle im Literaturverzeichnis u.U. falsch angegeben.  

Die häufigsten Reference Types finden Sie im Folgenden übersetzt:  

Book = Buch  

Book Section = Beitrag/Aufsatz in einem Sammelwerk  

Chart or Table = Grafik, Tabelle, Diagramm  

Conference Paper = Einzelner Beitrag einer Tagung  

Conference Proceeding = Tagungsberichte (gesammelt)  

Edited Book = Sammelband (=Sammlung mehrerer Artikel verschiedener Autoren, die von einem 
Hrsg. editiert wurden)  

Figure = Bild, Abbildung  

Generic = Allgemeiner Publikationstyp  

Journal Article = Artikel in einer Fachzeitschrift  

Web Page = Internetseite / -quelle 
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3.2 Titel aus Bibliothekskatalogen und Literaturdatenbanken exportieren 

Anhand des Bibliothekskatalogs Swisscovery (ube.swisscovery.slsp.ch) und der Datenbankoberfläche 
Ovid wird die Titelaufnahme nachfolgend erläutert.  

Titel aus Swisscovery importieren 

1. Führen Sie die gewünschte Suche im Katalog durch.  

2. Klicken Sie beim entsprechenden Suchergebnis auf die drei Punkte und wählen Sie Endnote oder 
RIS exportieren.  

 

Abbildung 3. Titel aus Swisscovery exportieren 

3. Bei Endnote wird der Titel nach EndNote Web exportiert. Mit Sync now unter Sync Status bzw. 
Sync Configuration (je nachdem, ob Sie angemeldet sind oder nicht) auf Ihrer EndNote-Desktop-
Installation können Sie die Aufnahme auf Ihren Desktop synchronisieren.  

4. Bei RIS exportieren können Sie die Codierung wählen (UTF-8 ist Standard) und den Download 
starten. Die heruntergeladene Datei (.ris) können Sie anschliessend manuell mit Öffnen mit… in 
EndNote öffnen, sofern dies nicht bereits automatisch oder mit Klick auf die Datei geschieht. Ihre 
mit RIS exportierten Titel finden Sie nun im Ordner Imported References und sind noch keiner 
Group zugeordnet.  

Titel aus einer Datenbank importieren 

1. Führen Sie die gewünschte Datenbanksuche durch. 
2. Klicken Sie nach Auswahl der gewünschten Suchtreffer auf Export. 

  

https://ube.swisscovery.slsp.ch/discovery/search?vid=41SLSP_UBE:UBE
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Abbildung 4. Suche in Ovid und Export ausgewählter Referenzen 

3. Wählen Sie zum Export das Format EndNote und den gewünschten Umfang.  

 
Abbildung 5. Export der vollständigen Referenz aus Ovid im Format für EndNote 
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4. Öffnen Sie die so erzeugte Datei mit EndNote. 

 
Abbildung 6. Die heruntergeladene Datei wird zum Import mit EndNote geöffnet 
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3.3 Online-Suche  

Mit EndNote können Sie zahlreiche Online-Datenbanken durchsuchen, wie z.B. den Katalog der 
Schweizerischen Nationalbibliothek, der Library of Congress oder PubMed.  

1. Wählen Sie links in der Navigationsleiste unter Online Search die gewünschte Datenbank oder den 
gewünschten Katalog aus.  

2. Geben Sie die Suchbegriffe ein und starten Sie die Suche.  

3. Ihnen werden nun alle Ergebnisse zu Ihrer Suche angezeigt, je nach dem auf Seiten verteilt. Sie 
können passende Titel markieren und mithilfe des  Symbols importieren. 

 
Abbildung 7. Titel aus Online Search importieren 

3.4 Volltextsuche 

Mit dem Befehl Find Full Text im Menü References sucht EndNote nach im Internet verfügbaren 
Volltexten (vgl. Abbildung 9).  

Um diese Funktion vollumfänglich nutzen zu können, muss in den Einstellungen (Menü Edit > 
Preferences) folgender Open-URL Path eingetragen sein (vgl. Abbildung 8):  

https://ube.swisscovery.slsp.ch/view/uresolver/41SLSP_UBE/openurl? 

  

Hinweis: 

Bei jeder Form von Datenübernahme sollten Sie die übernommenen Datensätze kontrollieren. Nur 
Titel, die korrekt in EndNote übernommen wurden, können später auch korrekt zitiert werden. 

https://ube.swisscovery.slsp.ch/view/uresolver/41SLSP_UBE/openurl?
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 Abbildung 8. OpenURL-Path in den Einstellungen zu Find Full Text 

Markieren Sie alle Referenzen, die in der Volltextsuche berücksichtigt werden sollen und starten Sie 
über das Kontextmenü (Rechtsklick) die Find-Full-Text-Suche. 

 
Abbildung 9. Volltextsuche in EndNote 

Um immer eine Kopie der angehängten Dateien in der EndNote Library zu speichern, wählen Sie im 
Menü Edit den Befehl Preferences. Unter dem Punkt URLs & Links setzen Sie dazu das Häkchen bei 
Copy new file attachments to the default file attachment folder and create a relative link. So haben Sie 
die Daten auch dann zur Hand, wenn Sie Dateien verschieben und EndNote eine Datei nicht mehr am 
ursprünglichen Speicherort findet. 
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3.5 Suche nach Duplikaten 

Mit dem Befehl Find Duplicates im Menü Library können Sie Ihre EndNote-Datenbank nach Duplikaten 
durchsuchen. Die gefundenen Duplikate werden nebeneinander angezeigt. Mit dem Button Keep This 
Record entscheiden Sie, welchen Datensatz Sie behalten; der jeweils andere Datensatz wird gelöscht. 

 
Abbildung 10. Suche nach Duplikaten 

4 Titel in EndNote suchen 

EndNote bietet für die Suche nach einzelnen Titeln die Simple Search und die Advanced Search an.  

4.1 Simple Search 

Die Simple Search durchsucht die Titeldaten Ihrer Quellen, die Kommentare, die Sie in Ihren PDF-
Dokumenten gemacht haben (PDF Notes) und den PDF-Volltext selbst, sofern dieser maschinenlesbar 
ist. Die eingegebenen Suchbegriffe werden mit UND verknüpft.  

Das Suchfeld der Simple Search befindet sich oberhalb Ihrer Referenzen.  

4.2 Advanced Search 

Mit der Advanced Search können Sie spezifische Datenfelder Ihrer Referenzen nach einem bestimmten 
Begriff oder Kriterium durchsuchen (vgl. Abbildung 11). Sie öffnen sie über die Tastenkombination Ctrl 
+ F oder über das Feld Advanced Search unterhalb der Simple Search.  
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Abbildung 11. Suche in EndNote 

Hier können Sie nach Autoren, Titel, Jahr, eigenen Bewertungen, Begriffen in Ihren PDF-Notes und 
PDFs sowie nach zahlreichen anderen Kriterien suchen. 

5 Titel in EndNote sortieren 

EndNote ermöglicht die Untergliederung der Daten in Gruppen (Groups) und unterscheidet nach 
Custom Groups, Smart Groups und From Groups. Den Custom Groups (oder nur Groups) ordnen Sie 
Datensätze per Hand zu. Die Smart Groups beruhen auf einer von Ihnen erstellten Suchanfrage und 
werden automatisch aktualisiert. Die From Groups (oder Combined Groups) führen die Titel mehrerer 
Custom und/oder Smart Groups zusammen. Auch sie werden automatisch aktualisiert. 

5.1 Group Sets 

So erstellen Sie ein Group Set: 

1. Wählen Sie aus dem Menü Groups den Befehl Create Group Set.  
2. Benennen Sie das neue Group Set.  

5.2 Custom Groups 

So erstellen Sie eine Custom Group: 

1. Klicken Sie mit der rechten Maustaste auf das Group Set, in dem die Custom Group erstellt 
werden soll.  

2. Wählen Sie aus dem Kontextmenü den Befehl Create Custom Group.  
3. Benennen Sie Ihre neue Custom Group. 

Um Daten in eine Custom Group einzufügen, können Sie die gewünschten Datensätze in der 
Referenzen-Übersicht markieren und per Drag & Drop in die Custom Group ziehen.  

5.3 Smart Groups 

Für die Erstellung einer Smart Group: 

1. Rechtsklick auf das Group Set, in dem die Smart Group erstellt werden soll.  
2. Wählen Sie aus dem Kontextmenü den Befehl Create Smart Group. 
3. Benennen Sie Ihre neue Smart Group.  
4. Geben Sie in der geöffneten Suchmaske Ihre Suchstrategie für die Smart Group ein und 

speichern Sie mit Save.  
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5.4 From Group 

So erstellen Sie eine From Group: 

1. Rechtsklick auf das Group Set, in dem die From Group erstellt werden soll. 
2. Wählen Sie aus dem Kontextmenü den Befehl Create From Groups. 
3. Vergeben Sie der neuen From Group einen Namen. 
4. Geben Sie an, aus welchen From Groups und/oder Custom Groups Sie Titel in Ihre neue From 

Group zusammenführen wollen.  

 

6 Zitieren mit dem Word Add-In CWYW (Cite While You Write) 

Mit EndNote können Sie Literaturverzeichnisse und Quellenangaben im Text jederzeit mühelos an-
legen und überarbeiten. Gehen Sie beim Einfügen von Zitaten wie folgt vor: 

1. Öffnen Sie das gewünschte Microsoft Word-Dokument. 
2. Navigieren Sie zum Reiter EndNote 20 im Menüband und wählen Sie Insert Citation. 
3. Geben Sie einen oder mehrere Suchbegriffe in das sich öffnende Suchfenster ein und klicken 

Sie auf Find. Alle Referenzen in den aktuell geöffneten Libraries, die Ihren Suchkriterien 
entsprechen, werden angezeigt.  

4. Markieren Sie die Referenz(en), die Sie einfügen möchten und wählen Sie Insert. 
5. Endnote fügt die Referenz im Dokument ein und erstellt den dazugehörigen Eintrag im 

Literaturverzeichnis im ausgewählten Output Style (Zitationsstil). 

 
Abbildung 12. CWYW (Cite While You Write)  

  

Achtung: 

Ein Datensatz kann mehreren Gruppen angehören, ist aber dennoch nur einmal in der Datenbank 
gespeichert. Wird ein Datensatz aus der Custom Group entfernt, wird er nicht komplett aus der 
EndNote Library, sondern nur aus der Custom Group gelöscht. Löschen Sie dagegen einen Titel aus 
einer Smart Group oder einer Combo Group, wird dieser ohne Warnung vollständig aus der 
Datenbank/Library gelöscht. 
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Falls Sie einen Fussnotenstil nutzen möchten, müssen Sie sich vor Beginn Ihres ersten Zitates definitiv 
dafür entscheiden. Danach können Sie nur noch zwischen verschiedenen Fussnotenstilen wechseln. 
Ein nachträglicher Wechsel von einem Fussnotenstil zu einem Autor-Jahr-Stil ist nicht mehr möglich. 

Um eine Fussnote einzufügen, gehen Sie wie folgt vor: 

1. Gehen Sie in Word zum EndNote 20-Reiter und wählen Sie über Style einen Fussnotenstil aus, 
mit dem Sie zitieren möchten. Ein Beispiel für einen Fussnotenstil wäre der Chicago-Stil.  

2. Klicken Sie mit dem Cursor in die Stelle in Ihrem Text, an dem Sie die Fussnote einfügen 
möchten. Navigieren Sie nun im Menüband von Word zum Reiter Referenzen und klicken Sie 
auf Fussnote einfügen.  

3. Mit dem Cursor in dieser Fussnote gehen Sie wieder zum EndNote-Reiter und fügen Ihre 
Referenz wie gehabt via Insert Citation ein.  

4. EndNote fügt die Referenz(en) in die zuvor über Word generierte Fussnote ein und erstellt den 
dazugehörigen Eintrag im Literaturverzeichnis.  

CWYW steht auch für Open Office Writer und Apple Pages zur Verfügung.  

Seitenangaben hinzufügen 

Über Edit & Manage Citation(s) werden zusätzliche Angaben, wie beispielsweise Seitenangaben der 
zitierten Quelle, hinzugefügt.  

7 Literaturlisten formatieren und Zitationsstile wechseln 

Sobald Sie über EndNote die erste Quellenangabe in Ihren Text einbinden, erstellt EndNote auto-
matisch ein Literaturverzeichnis. Dieses befindet sich üblicherweise am Ende des Dokuments und wird 
laufend aktualisiert.  

Den Zitationsstil wählen Sie über das Dropdown-Menü Style aus, in dem sich häufig verwendete Stile 
befinden. Über Select another style können Sie unter allen in EndNote installierten Zitationsstilen 
wählen. Über den Button Bibliography (Mac: Bibliography Settings) können Sie Layout und Überschrift 
der Literaturliste bestimmen.  

8 Textunabhängige Literaturlisten erstellen 

Um unabhängig von einem Text eine Literaturliste zu erstellen, gehen Sie folgendermassen vor.  

1. Wählen Sie in EndNote die Referenzen aus, die auf Ihrer Literaturliste erscheinen sollen.  
2. Gehen Sie im Tools-Menü auf den Punkt Subject Bibliography.  
3. Wählen Sie aus, nach welchen Kriterien Ihre Literaturliste erstellt werden soll (Autor, Titel, 

Erscheinungsjahr, Schlagwort, etc.).  
4. Es öffnet sich eine Liste aller Autoren (wenn Sie als Kriterium den Autor gewählt haben) mit der 

Angabe, wie viele Titel zu dieser Person existieren.  
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5. Wählen Sie alle Autoren aus, die auf Ihrer Liste erscheinen sollen, und klicken Sie erneut auf 
OK.  

6. Sie erhalten nun eine Liste aller Veröffentlichungen, nach Autoren gruppiert.  
7. Wählen Sie den gewünschten Zitationsstil.  
8. Über den Button Layout haben Sie die Möglichkeit, weitere Einstellungen vorzunehmen (z.B. 

die Sortierung).  
9. Nun können Sie die Literaturliste speichern, drucken oder als Druckvorschau anzeigen lassen.  

Literaturlisten erstellen – die schnelle Art 

Um möglichst schnell eine Literaturliste zu erstellen: 

1. Markieren Sie die benötigten Referenzen. 
2. Wählen Sie den gewünschten Zitationsstil. 
3. Gehen Sie über File -> Print Preview zur Druckvorschau oder kopieren Sie die ausgewählten 

Referenzen über Edit -> Copy in ein Textdokument.  

9 Sonstiges 

Um Ihre Daten zu sichern, sollten Sie regelmässig Sicherungskopien erstellen. Sie haben dabei zwei 
Möglichkeiten: Entweder Sie speichern Ihre Daten in Form einer Compressed Library im .enlx-Format, 
oder Sie exportieren die Library im .txt-, .rtf-, .htm- oder .xml-Format. Beide Möglichkeiten finden Sie im 
Menü File. 

Weiter können Sie Ihre EndNote-Installation Ihren Bedürfnissen anpassen. Weitere Informationen dazu 
finden Sie hier: 

• Connection Files: https://www.endnote.com/downloads/connection-files/ 
Diese Dateien ermöglichen die Recherche in einzelnen Datenbanken und Bibliothekskatalogen 
aus EndNote heraus, indem sie die nötige Verbindung zwischen Programm und Datenbank 
schaffen.  

• Import Filter: https://www.endnote.com/downloads/filters/ 
Diese Dateien ermöglichen es, EndNote Titeldaten in unterschiedlichen Formaten aus 
unterschiedlichen Datenbanken und Katalogen in EndNote einzulesen.  

• Updates: https://endnote.com/downloads/available-updates/ 
• Output Styles (Zitationsstile): https://www.endnote.com/downloads/styles/ 

  

https://www.endnote.com/downloads/connection-files/
https://www.endnote.com/downloads/filters/
https://endnote.com/downloads/available-updates/
https://www.endnote.com/downloads/styles/
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10 Kontakt 

 
Universitätsbibliothek Bern 
Hochschulstrasse 6 
3012 Bern 

Anfragen: literaturverwaltung@ub.unibe.ch 

EndNote-Kurs an der UB Bern 

Mit dem ILIAS-Link https://ilias.unibe.ch/goto.php?target=crs_1572085 gelangen Sie zu unserem 
EndNote-Kurs.  

Informationen und Details zu unserem Kursangebot finden Sie auch auf unserer Webseite.  

Handbuch 

In EndNote finden Sie unter dem Menüpunkt Help -> Contents (F1) das Handbuch zum Programm. 

Technischer Support: https://support.clarivate.com/s/ 

 

mailto:literaturverwaltung@ub.unibe.ch
https://ilias.unibe.ch/goto.php?target=crs_1572085
https://www.unibe.ch/universitaet/dienstleistungen/universitaetsbibliothek/service/kurse_und_beratung/endnote_basiskurs/index_ger.html
https://support.clarivate.com/s/
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